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Foreword  

Thank you for purchasing IBOX66 Embedded Industrial Computer (“the Device” or “the 
Product”). This manual intends to provide guidance and assistance necessary on setting up, 
operating or maintaining the Product. Please read this manual and make sure you understand 
the structure and functionality of the Product before putting it into use. 

Intended Users 

This manual is intended for: 

• Operator of the Device 
• Technical support engineers 
• Other users 

Copyright 

Vantron Technology, Inc. (“Vantron”) reserves all rights of this manual, including the right to 
change the content, form, product features, and specifications contained herein at any time 
without prior notice. An up-to-date version of this manual is available at 
www.vantrontech.com.  

The trademarks in this manual, registered or not, are properties of their respective owners. 
Under no circumstances shall any part of this user manual be copied, reproduced, translated, 
or sold. This manual is not intended to be altered or used for other purposes unless otherwise 
permitted in writing by Vantron. Vantron reserves the right of all publicly released copies of 
this manual. 

Disclaimer 

While all information contained herein has been carefully checked to assure its accuracy in 
technical details and typography, Vantron does not assume any responsibility resulting from 
any error or features of this manual, nor from improper uses of this manual or the software.  

It is our practice to change part numbers when published ratings or features are changed, or 
when significant construction changes are made. However, some specifications of the Product 
may be changed without notice. 
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Technical Support and Assistance 

Should you have any question about the Product that is not covered in this manual, contact 
your sales representative for solution. Please contain the following information in your 
question: 

• Product name and PO number; 
• Complete description of the problem; 
• Error message you received, if any. 

 

Vantron Technology, Inc.  

Address: 48434 Milmont Drive, Fremont, CA 94538  
Tel: (650) 422-3128  
Email: sales@vantrontech.com 
 

Regulatory Information 

The Product is designed to comply with: 

• Part 15 of the FCC Rules; 

Please refer to the Appendix for Regulatory Compliance Statement. 

 

Symbology  

This manual uses the following signs to prompt users to pay special attention to relevant 
information. 

 Caution for latent damage to system or harm to personnel  

 Attention to important information or regulations 
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General Safety Instructions  

The Product is supposed be installed by knowledgeable, skilled persons familiar with local 
and/or international electrical codes and regulations. For your safety and prevention of 
damage to the Product and other equipment connected to it, please read and observe 
carefully the following safety instructions prior to installation and operation. Keep this manual 
well for future reference.  

• Do not disassemble or otherwise modify the Product. Such action may cause heat 
generation, ignition, electronic shock, or other damages including human injury, and may 
void your warranty.  

• Keep the Product away from heat source, such as heater, heat dissipater, or engine casing. 

• Do not insert foreign materials into any opening of the Product as it may cause the 
Product to malfunction or burn out.   

• To ensure proper functioning and prevent overheating of the Product, do not cover or 
block the ventilation holes of the Product. 

• Follow the installation instructions with the installation tools provided or recommended. 

• The use or placement of the operation tools shall comply with the code of practice of 
such tools to avoid short circuit of the Product. 

• Cut off the power before inspection of the Product to avoid human injury or product 
damage. 
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Precautions for Power Cables and Accessories 

Use proper power source only. Make sure the supply voltage falls within the specified 
range. The Product is designed to use 9-36V DC. Always check whether the Product is DC 
powered before applying power.  

Place the cables properly at places without extrusion hazards. 

Use only approved antenna(s). Non-approved antenna(s) may produce spurious or 
excessive RF transmitting power which may violate FCC limits. 

Cleaning instructions:  

• Power off before cleaning the Product 
• Do not use spray detergent 
• Clean with a damp cloth 
• Do not try to clean exposed electronic components unless with a dust collector 

Power off and contact Vantron technical support engineer in case of the following faults: 

• The Product is damaged 
• The temperature is excessively high 
• Fault is still not solved after troubleshooting according to this manual 

Do not use in combustible and explosive environment: 

• Keep away from combustible and explosive environment 
• Keep away from all energized circuits 
• Unauthorized removal of the enclosure from the device is not allowed 
• Do not change components unless the power cable is unplugged 
• In some cases, the device may still have residual voltage even if the power cable is 

unplugged. Therefore, it is a must to remove and fully discharge the device before 
replacement of the components. 
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 CHAPTER 1 INTRODUCTION 
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1.1 Product Overview 

Vantron IBOX66 is a multi-functional embedded industrial computer designed for smart 
businesses. Running Android 11 operating system, the high-performance industrial 
computer is GMS certified to enable customers to have unimpeded access to Google 
mobile services. Moreover, customers have the option of Linux systems for more flexibility 
and system customization. 

IBOX66 is running on RK3566, a cost-effective multi-core processor developed by Rockchip. 
With 4GB memory and 32GB eMMC storage, it features quick access to data and ultra large 
capacity. As such, it is capable of dealing with huge volume of data in a timely manner. 

As IBOX66 provides rich interfaces, a wide choice of peripherals can be connected for 
extended applications, including barcode scanners, cameras, barcode printers and 
keyboard plates. It also supports ultra-high-definition video outputs thanks to the high-
performance video engine coupled with H.265 (HEVC) hardware decoding and 1080p/4K 
video decoding. Moreover, display interfaces of different specifications allow flexible 
application of the device in intelligent retailing, new retailing, financial self-service 
terminals, and other scenarios.  
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1.2 Unpacking 

The Product has been carefully packed with special attention to quality. However, should 
you find any component damaged or missing, please contact your sales representative in 
due time. 

 

Standard accessories Optional accessories 

 
1 x IBOX66 

Industrial computer 
 

1 x 12V DC Power 
adapter & power cord 

 1 x Wi-Fi & BT 
antenna 

 1 x DC power connector 

\ \  2 x 4G LTE antenna 

    

 

 Actual accessories might vary slightly from the list above as the customer order might 
be different from the standard configuration options. 
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1.3 Specifications  

IBOX66  

System 

CPU Rockchip RK3566, Quad core ARM Cortex-A55 Processor, 
1.8GHz (Max.) 

Memory 4GB (up to 8GB) 

Storage 32GB (up to 128GB) 
1 x Micro SD slot (up to 128GB) 

Communication 
Ethernet 1 x RJ45, 10M/100M/1000Mbps 
4G LTE (AT&T, Verizon) Optional 
Wi-Fi & Bluetooth Wi-Fi 802.11 a/b/g/n/ac + BT 5.0 

Media 

Display 

1 x HDMI, Type-A 
1 x 4-lane eDP, 2560 x 1600 @60Hz 
1 x 8-lane MIPI DSI (including 4 lanes multiplexed to LVDS), 

single-channel MIPI DSI: 1920 x 1080 @60Hz, LVDS: 720P 
@60Hz; dual-channel MIPI DSI: 2560 x 1440 @60Hz 

Audio 1 x 3.5mm Combo audio jack 
Speaker 1 x Speaker connector 
Camera 1 x MIPI CSI, 2 x 10 x 2.0mm 

I/Os 

Serial port 2 x RS232, DB9 Connector 
2 x RS232/RS485, DB9 Connector 

USB 4 x USB 2.0 Type-A (USB OTG supported by the top right port) 
1 x USB 3.0 Type-A 

SIM slot 1 x Micro SIM slot 
GPIO 8 x GPIO, 3.3V 
Watchdog Supported 
RTC Supported 

Expansion Mini-PCIe 1 x Mini-PCIe for LTE module 

System Control 

Button 1 x ON/OFF button 
1 x Reset button 

LED 

1 x Power LED (Red) 
1 x System LED (Green) 
1 x 4G LED (Green) 
1 x User defined (Green) 

Software 

OS Android 11, GMS certified (Optional: Linux OS) 
Device management 
platform BlueSphere MDM (Android version only) 

OTA tool BlueSphere OTA 

Power 
Input 12V/24V 3A DC (±5%) 

1 x 3 x 3.81mm power terminal 
Consumption 15W 

Mechanical 
Dimensions 160mm x 110mm x 30mm (Enclosure only) 

195mm x 110mm x 30mm (With installation bracket) 
Weight 680g 
Installation Desktop/Wall mounting 

Environment 
Condition 

Temperature Operating: 0℃~+60℃ Storage: -40℃~+85℃ 

Humidity Operating: 5%~95% RH Storage: 5%~95% RH 

Certification FCC 
ESD: ±4KV (contact) and ±8KV (air) 
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1.4 Product Layout     

 
1.4.1 Front view 

 

 
 
 
 
 
 
 
 
 

1.4.2 Back view 

 
 
 
 
 
 
 

  

USB 3.0 
Type-A Ethernet 

jack 

Audio jack 

Micro SD & 
Micro SIM slots 

OTG 
supported 

4G master 
antenna 

HDMI 
USB 2.0 
Type-A 

ON/OFF  
button 

OTG 
switch DC in 

Installation 
bracket 

Installation 
bracket 

RS232 RS485/RS232 

Installation 
bracket 

Installation 
bracket 

LED 
indicator

 

Wi-Fi & BT 
antenna  
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1.4.3 Left side view 

 

 

 

 

 

 

 

 
 
 
 
 

1.4.4 Right side view 
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1.5 Operating System 

IBOX66 runs Android 11 operating system with GMS certified and users have the option of 
Linux operating systems. 

1.6 Mechanical Dimensions 
• 160mm x 110mm x 30mm (Enclosure only) 
• 195mm x 110mm x 30mm (With installation bracket)  

 

 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

1.7 Power Supply and Consumption 

IBOX66 works with 12V/24V 3A DC power input supplied by the power terminal.  

The power consumption of IBOX66 is about 15W. It should be pointed out that the power 
consumption is largely dependent on the RAM, storage capacity, peripherals, and other 
configurations of the Product. 
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CHAPTER 2 GETTING STARTED 
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2.1 Device Setup 

Before you proceed with the configuration of IBOX66, follow the steps below to finish 
hardware connection. 

1. Position the Device on a desired place, for instance, a wall or a desktop; 

 

 

 

 

 

 

2. Align the screws (M4 x 6 / M4 x 8 recommended) to the screw holes reserved on the 
mounting bracket, and mark the position of the screws on the wall or the desktop; 

 

 

 

 

 

 

 

3. Drill four screw holes on the marks made in the prior step; 
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4. Place the Device back and adjust the position of the bracket, if needed, then use a 
screwdriver to tighten the screws and secure the device; 

 

 

 

 

 

 

5. Insert an activated Micro SIM card, if any, into the Micro SIM slot with the gold-colored 
contacts facing up, then push the card to secure it; 

 

 

 

 

6. Insert a Micro SD card, if any, into the corresponsive slot with the gold-color contacts 
facing down, then push the card to secure it; 

 

 

 

 

7. Install the antennas to the antenna connectors and tighten the connectors; 

 

 

 

 

 
 
 
 
 

If you have only one 4G antenna in hand, please install it to the 4G primary antenna 
connector next to the ON/OFF button.   
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8. When necessary, plug one end of an Ethernet cable into the RJ45 jack of IBOX66 and 
the other to a live Ethernet port; 

 

 

 

 

 

 

9. Insert the terminal end of the female DC connector into the power terminal of IBox66 
and the other end into the power adapter; 

 

 

 

 

 

 
 
 

10. Plug the adapter to a power outlet that meets the supply voltage requirement 
(12V/24V DC) to turn on the IBOX66.  

If you are using the DC power connector supplied by Vantron  
Red wire:   + 
Black wire:  - 
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2.2 Using the Device 

To access the GUI of the device, follow the steps below to connect it to a mouse, keyboard 
and monitor. 

1. Insert one end of an eDP/LVDS/HDMI cable to the corresponsive video interface of the 
device and the other end to a monitor; 

The video cable shall vary with the interface to be connected, and an adapter connector 
is sometimes needed (HDMI interface for illustration here). 

 

 

 

 

 

2. Connect a mouse and keyboard separately to the USB interfaces on the device; 

 

 

 

 

 

 

3. Power on the device using a 12V/24 DC power adapter; 

 

4. To debug the device remotely, dial the OTG switch up (client mode) and insert a USB 
Type-A to Type-A cable into the USB OTG port to connect the device and the host 
computer. 

 

 

 

 

 

  

USB OTG OTG switch 
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2.3 Turning on/off the Device 

Having set up IBOX66 according to the aforementioned steps, users can operate the device 
following the steps below: 

• The device will automatically boot up after power-on; 

• After IBOX6425E starts up, users can: 

1. Press the Reset button once to restart the device; 

2. Press the ON/OFF button once to turn off the monitor/wake up the device from 
the sleep mode; 

3. Press the ON/OFF button and hold for about 2 seconds to call the power menu, 
and click Power off to turn off the device orderly; 

4. Press the ON/OFF button and hold for about 5 seconds to turn off the device 
directly; 

5. When necessary, unplug the power adapter from the power connector of IBOX66 
or the outlet to force shutdown.  

 

The action might vary with the operating system. 

 

  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 IBOX66 | User Manual               18            www.vantrontech.com 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CHAPTER 3 HARWARE DESCRIPTION  
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This section briefs on the hardware definition and connector/jumper pinout. 

3.1 Power input 

IBOX66 is designed to support 12V/24V DC (12V 3A recommended) power input with 
OVP/OCP protection. Since the terminal block also provides backlight power supply, please 
take the input voltage of the backlight into consideration when selecting the power supply. 

Specification of the power connector: 1 x 3-pin, 3.81mm, 10A  

 

  

 

 

Pinout description: 

Pin Signal Description 

1 GND Ground 

2 -VDC 12V Power input - 

3 +VDC 12V Power input + 

 

3.2 ON/OFF button 

 

 

 

Button definition (Android OS): 

Action (with power connected) Description 

Short press 
Enable sleep mode or wake up the device  

Turn on the device if it is previously turned off 

Press and hold for 1~2 seconds 
Open the power menu to power off/restart the 

device/make an emergency call 

Press and hold for 5 seconds Power off the device 

 

  

Pin 1 
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Button definition (Linux OS): 

Action (with power connected) Description 

Short press Turn on the device 

Press and hold for 5 seconds Power off the device 

3.3 Ethernet port 

IBOX66 implements an Ethernet port. 

Specification: RJ45, supporting 10M/100M/1000M Base-T. The Ethernet connector has 
two link/act LEDs to indicate the working status of the Ethernet. The solid green indicator 
means it supports 1000Mbps transmission rate and the blinking amber indicator means 
the network is functioning properly and the transmission rate is 10/100Mbps. 

 

 

 

3.4 USB 2.0 

IBOX66 offers four USB 2.0 interfaces (Type-A), including one USB OTG on the top right that 
can switch between host (down) and device (up) modes with the red switch next to the 
USB interfaces. When switching the OTG modes, please position the switch in place before 
plugging into the USB cable. 

 

 

 

 

Make sure you have switched the USB OTG to the device mode before connecting the 
device to a host computer for App installation or image flashing. 

  

USB OTG 

Switch 
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3.5 USB 3.0  

IBOX66 offers a USB 3.0 Type-A interface for connecting a peripheral. 

3.6 HDMI port  

IBOX66 offers an HDMI port (Type-A) for connecting a display, supporting HDMI 2.0a 
protocol with resolution up to 4K × 2K @60Hz. 

3.7 Micro SD & Micro SIM slots 

IBOX66 provides a Micro SD card slot that supports a storage device of up to 128GB.  

The SIM card slot supports SIM card hot plugging. The 4G LTE module of the Device is AT&T 
and Verizon pre-certified, and you may consult your sales executive for the module name 
before applying a SIM card from the carrier. 

3.8 Audio jack 

IBOX66 offers a 3.5mm 4-pole combo audio jack supporting headphone and microphone 
functions. 

3.9 Serial ports 

IBOX66 implements two DB9 RS232 connectors (uart4 and uart5) and two DB9 
RS232/RS485 multiplexers (uart0 and uart7) for serial communication. 

The two RS232 connectors are mapped as /dev/ttyS4 and /dev/ttyS5 respectively, while 
the two RS232/RS485 connectors are mapped as /dev/ttyS0 and /dev/ttyS7 respectively. 

 

 

 

 

 

 

 

 

  

RS232 
(uart4) 

RS232/RS485 
(uart7) 

RS232/RS485 
(uart0) 

  

RS232 
(uart5) 
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Pinout description of UART4: 

No.  Signal Description 

1 / / 

2 RXDA RS232_A receive data 

3 TXDA RS232_A Transmit data 

4 / / 

5 GND  Ground 

6 / / 

7 / / 

8 / / 

9 / / 

Pinout description of UART5: 

No.  Signal Description 

1 / / 

2 RXDB RS232_B receive data 

3 TXDB RS232_B Transmit data 

4 / / 

5 GND  Ground 

6 / / 

7 / / 

8 / / 

9 / / 

 

  

1 5 

6 9 
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Pinout description of UART0: 

No.  Signal Description 

1 RS485_1_A RS485_1 A 

2 RXDE/RS485_1__B RS232_E receive data /RS485_1 B 

3 TXDE RS232_E Transmit data 

4 / / 

5 GND Ground 

6 / / 

7 / / 

8 / / 

9 / / 

Pinout description of UART7: 

No.  Signal Description 

1 RS485_2_A RS485_2 A 

2 RXDF/RS485_2__B RS232_F receive data /RS485_2 B 

3 TXDF RS232_F Transmit data 

4 / / 

5 GND Ground 

6 / / 

7 / / 

8 / / 

9 / / 
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3.10 Reset button  

IBOX66 offers a reset button which will restart the device upon a short press. 

3.11 LED indicators 

IBOX66 offers four LED indicators with definition explained below: 

 

 

 

 

Indicator name Definition 

4G indicator 
Blinking: 4G communication working properly 

Off: Problem with 4G communication 

USER indicator 
Refer to 4.8 for the command to enable the LED in Android 

system 

POWER indicator 
Solid red: System power OK 

Off: Problem with system power 

SYS indicator 
Solid green: System running properly 

Off: System abnormality 

 

If the power indicator is on while the other three indicators are off, the Device is shut 
down with power connected. 
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3.12 GPIO 

IBOX66 provides 8 GPIOs on a 20-pin connector (2 × 10 × 2.0mm) to allow custom 
development of the Device. 

 

 

 

Pinout description: 

Pin Signal Description 

1 GND Ground 

2 GND Ground 

3 CPU_GPIO0 CPU general purpose input output 

4 CPU_GPIO4 CPU general purpose input output 

5 GND Ground 

6 GND Ground 

7 CPU_GPIO1 CPU general purpose input output 

8 CPU_GPIO5 CPU general purpose input output 

9 VCC_EXT_3V3 DC 3.3V external power output 

10 VCC_EXT_3V3 DC 3.3V external power output 

11 GND Ground 

12 GND Ground 

13 CPU_GPIO2 CPU general purpose input output 

14 CPU_GPIO6 CPU general purpose input output 

15 GND Ground 

16 GND Ground 

17 CPU_GPIO3 CPU general purpose input output 

18 CPU_GPIO7 CPU general purpose input output 

19 VCC_EXT_3V3 DC 3.3V general purpose input output 

20 VCC_EXT_3V3 DC 3.3V general purpose input output 
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3.13 eDP & backlight connector 

IBOX66 implements a 4-lane eDP connector (2 × 10 × 2.0mm) to connect to an external 
display via an extension cable. Moreover, there is an LCD backlight power connector BL1 
(1 x 6 x 2.0mm) that supplies power to the LCD backlight.  

 

 

 

eDP pinout description:  

Pin Signal Description 

1 EDP_TX_D0N eDP differential lane 0 negative 

2 EDP_TX_D1N eDP differential lane 1 negative 

3 EDP_TX_D0P eDP differential lane 0 positive 

4 EDP_TX_D1P eDP differential lane 1 positive 

5 GND Digital ground 

6 GND Digital ground 

7 EDP_TX_D2N eDP differential lane 2 negative 

8 EDP_TX_D3N eDP differential lane 3 negative 

9 EDP_TX_D2P eDP differential lane 2 positive 

10 EDP_TX_D3P eDP differential lane 3 positive 

11 GND Digital ground 

12 GND Digital ground 

13 EDP_TX_AUXN eDP differential AUX channel negative 

14 eDP_HPD Hot Plug Detect 

15 EDP_TX_AUXP eDP differential AUX channel positive 

16 GND Digital ground 

17 GND Digital ground 

18 GND Digital ground 

19 EDP_VDD Power Supply 

20 EDP_VDD Power Supply 

 

  

eDP 
interface 

Backlight 
connector 
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BL1 connector pinout description: 

Pin Signal Description 

1 EDP_BLK LCD power supply for LED driver 

2 EDP_BLK LCD power supply for LED driver 

3 EDP_BKLT_EN LED driver enabling 

4 EDP_BKLT_PWM PWM signal for LED driver 

5 GND Ground 

6 GND Ground 

3.14 Speaker  

IBOX66 provides an L/R speaker connector (1 × 4 × 2.0mm) that allows connection of a 
5W/8Ω speaker.  

 

 

 

 

Pinout description: 

Pin Signal Description 

1 OUTR- Class-D H-bridge negative output for right channel 

2 OUTR+ Class-D H-bridge positive output for right channel 

3 OUTL- Class-D H-bridge negative output for left channel 

4 OUTL+ Class-D H-bridge positive output for left channel 

3.15 Grounding screw 

The grounding screw on IBOX66 helps avoid any fatal electrical accidents and ensure the 
durability of the device.  

 

  

Pin 1 
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3.16 MIPI DSI/LVDS  

IBOX66 implements a dual-channel 8-lane MIPI DSI connector (2 × 16 × 2.0mm) to connect 
an external screen via an extension cable, including 4 lanes that can be used as LVDS. 
Moreover, there is an LCD backlight power connector BL2 (1 x 6 x 2.0mm) that supplies 
power to the LCD backlight.  

 

 

 

 MIPI DSI/LVDS pinout description:  

Pin Signal Description 

1 MIPI1_DSI_DN3 MIPI1_DSI Differential Lane 3 - 

2 MIPI1_DSI_DP3 MIPI1_DSI Differential Lane 3 + 

3 MIPI1_DSI_CLKN MIPI1_DSI Differential Clock Lane - 

4 MIPI1_DSI_CLKP MIPI1_DSI Differential Clock Lane + 

5 GND Digital Ground 

6 GND Digital Ground 

7 MIPI1_DSI_DN2 MIPI1_DSI Differential Lane 2 - 

8 MIPI1_DSI_DP2 MIPI1_DSI Differential Lane 2 + 

9 MIPI1_DSI_DN1 MIPI1_DSI Differential Lane 1 - 

10 MIPI1_DSI_DP1 MIPI1_DSI Differential Lane 1 + 

11 MIPI1_DSI_DN0 MIPI1_DSI Differential Lane 0 - 

12 MIPI1_DSI_DP0 MIPI1_DSI Differential Lane0 + 

13 LVDS_MIPI0_DN3 LVDS/MIPI_DSI Differential Lane 3 - 

14 LVDS_MIPI0_DP3 LVDS/MIPI_DSI Differential Lane 3 + 

15 LVDS_MIPI0_CLKN LVDS/MIPI_DSI Differential Clock Lane - 

16 LVDS_MIPI0_CLKP LVDS/MIPI_DSI Differential Clock Lane + 

17 GND Digital Ground 

18 GND Digital Ground 

19 LVDS_MIPI0_DN2 LVDS/MIPI_DSI Differential Lane 2 - 

20 LVDS_MIPI0_DP2 LVDS/MIPI_DSI Differential Lane 2 + 

21 LVDS_MIPI0_DN1 LVDS/MIPI_DSI Differential Lane 1 - 

22 LVDS_MIPI0_DP1 LVDS/MIPI_DSI Differential Lane 1 + 

23 LVDS_MIPI0_DN0 LVDS/MIPI_DSI Differential Lane 0 - 
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24 LVDS_MIPI0_DP0 LVDS/MIPI_DSI Differential Lane 0 + 

25 GND Digital Ground 

26 GND Digital Ground 

27 LVDS_PWR Power Supply 

28 GND Digital Ground 

29 LVDS_PWR Power Supply  

30 LVDS_PWR Power Supply 

31 GND Digital Ground 

32 GND Digital Ground 

BL2 connector pinout description: 

Pin Signal Description 

1 LCD_BLK LCD Power Supply for LED Driver 

2 LCD_BLK LCD Power Supply for LED Driver 

3 LCD_BKLT_EN LED Driver Enabling 

4 LCD_BKLT_PWM PWM Signal for LED Driver 

5 GND Ground 

6 GND Ground 
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3.17 MIPI CSI 

IBOX66 implements a 4-lane MIPI CSI connector (2 × 10 × 2.0mm) for HD cameras via an 
extension cable. 

 

 

 

Pinout description: 

Pin Signal Description 

1 MIPI_CSI_RX_D2N MIPI-CSI differential lane 2 negative 

2 MIPI_CSI_RX_D3N MIPI-CSI differential lane 3 negative 

3 MIPI_CSI_RX_D2P MIPI-CSI differential lane 2 positive 

4 MIPI_CSI_RX_D3P MIPI-CSI differential lane 3 positive 

5 GND Digital ground 

6 GND Digital ground 

7 MIPI_CSI_RX_D0N MIPI-CSI differential lane 0 negative 

8 MIPI_CSI_RX_D1N MIPI-CSI differential lane 1 negative 

9 MIPI_CSI_RX_D0P MIPI-CSI differential lane 0 positive 

10 MIPI_CSI_RX_D1P MIPI-CSI differential lane 1 positive 

11 MIPI_ CSI_RX _CLK0N MIPI-CSI differential clock lane negative 

12 I2C2_SCL I2C serial port 2 clock signal 

13 MIPI_ CSI_RX _CLK0P MIPI-CSI differential clock lane positive 

14 I2C2_SDA4 I2C serial port 2 data signal 

15 MCLK Main Clock 

16 CAM_RST Reset control signal 

17 VCC1V8_DVP 1.8V IO power 

18 CAM_PWN Power down control signal 

19 VCC1V5_DVP 1.5V Core power 

20 VCC2V8_DVP 2.8V Analog power 
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 CHAPTER 4 ANDROID SYSTEM MANUAL 
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This chapter briefs on the settings and common use of the interfaces in the Android system. 
Please connect a mouse, keyboard and monitor to IBOX66 for smooth operation. 

4.1 Time and Date Setup  

Please confirm if the system time is correct after first bootup. Change of the system 
settings will synchronize the date and time to the RTC which ensures correct display of the 
system time and date after recovery from abrupt power failure or system fault.  

1. Swipe up to unlock the screen; 

2. Navigate to Settings > System > Time and Date in sequence to enter the settings page; 

3. By default, the system applies the date and time zone provided by the network, you 
can keep the settings or change the them manually; 

4. If the system applies the time zone provided by network, please confirm if the time 
zone coincides with your local time zone. If not, please disable the option first; 

5. Then click the Time Zone to access the settings page; 

6. Select a region where the device is located (for instance, United States); 

7. Select a proper time zone for it; 

8. Enable the Time zone provided by network option, which will not change the settings 
you have made; 

9. You can then choose to set the date and time manually or synchronize to the network 
time. If you use the time provided by network, the system time will automatically align 
to the current time zone; 

10. When the time and date are all set, they will be synchronized to the RTC. 

 

To ensure smooth setup, please make sure the Device is connected to Internet if you 
choose the network time.  
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4.2 Enable Developer Options 

To enable Developer options of IBOX66, follow the steps below: 

1. Connect IBOX66 to a mouse, keyboard and monitor for easier operations; 

2. After the system has booted, swipe up to access the application drawer; 

3. Click Settings > About <Tablet> in sequence;  

4. Scroll down to Build number, and click it consecutively for at least 7 times until you 
see a prompt indicating you are now a developer; 

5. Go back to Settings > System > Advanced > Developer options and toggle on USB 
debugging (under the DEBUGGING sub-menu), then you can customize the device 
settings. 

6. Depending on the Android version, the entry might vary slightly. 

 

4.3 ADB Setup on the Windows host 

Android Debug Bridge (ADB) is a tool that is designed to connect your development 
workstation directly to your Android device for debugging, device upgrading, app 
installation, etc. 

Adding the ADB executable file to the system’s environment variable allows you to run the 
ADB tool regardless of your current working directory. 

Follow the steps below to set up the ADB on the Windows host. 

1. Unzip the software release package and navigate to the following directory: \SW\tools; 

2. Extract the adb_fastboot_and_other_tools_for_windows zip file; 

3. Navigate to the Android folder that contains the ADB tool kit, and copy the folder path; 
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4. Press “Win + R” and input sysdm.cpl in the dialogue box to open the settings interface; 

 

 

5. Click in sequence Advanced > Environment Variables > System Variables > Path > Edit, 
and click New in the pop-up; 

 

6. Paste the path of the Android folder, and click OK one by one to confirm and exit; 
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7. Press “Win + R” and input cmd in the dialogue box to open the command prompt; 

8. Input adb version in the command prompt to check if the ADB tool is installed. 

 

 

 

 

 

 

 

 

4.4 App Installation via ADB Commands  

In addition to the standard pre-installed Android applications, users can install their own 
applications on the device provided that it runs Android system and the ADB tool kit is 
installed and accessible on the Windows host computer. 

4.4.1 Prerequisites 

• IBOX66 running Android operating system 

• A host computer running Windows 7 or later (with ADB setup finished) 

• A USB cable (Type-A to Type-A) 

• The device is in client mode (OTG switch dialed up) 
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4.4.2 App installation 

1. Connect the device and the host computer via the USB Type-A to Type-A cable; 

2. Press “Win + R” and input cmd in the dialogue box to open the command prompt; 

3. Input adb devices -l in the command prompt to check if the device is connected to the 
host computer; 

 

 

4. When the device information is displayed under the command, you can copy the serial 
number (squared as shown above) for the next-step use; 

5. Input the following command line to install the app; 

adb -s <serial number> install <APP path> 

6. The installation will be executed after the command line is input and the result of 
installation will be displayed below the command; 

  

 

7. The newly installed app will be displayed on the App drawer in the Alphabetic order. 

 

 

The screenshots are for illustration only and are not intended to represent the actual 
device number and other information of the device currently in your possession. 

In step 5 shown above, you can drag the .apk file from the local directory to the 
command line to replace the <App path> you typed in manually.  

Make sure there is no special character in the app path. If you failed to install the apk, 
try using the absolute path of the .apk file enclosed in double quotation marks.  
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4.5 Image Flashing on a Windows Host 

Whenever a new image is available, Vantron will provide a release package consisting of 
all the tools/files necessary so that you can flash the image as needed. This section briefs 
on the image flashing on a Windows host. 

4.5.1 Prerequisites  

• IBOX66 

• A host computer running Windows 7 or later (with ADB setup finished) 

• A USB Type-A to Type-A cable 

• The device is in client mode (OTG switch dialed up) 

4.5.2 Image flashing  

1. Unzip the release package, and open the directory of the upgrade driver (\SW\ 
DriverAssitant_vxxx) to locate the DriverInstall.exe; 

 

2. Right click the mouse and run the program as administrator; 

3. Click Uninstall Driver first to remove the previously installed driver, if any, then click 
Install Driver and wait; 
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4. A pop-up will appear in a second suggesting the driver is installed; 

 

5. Open the directory of the upgrade tool (path: \SW\AndroidTool\RKDevTool_Release_ 
vxxx\RKDevTool); 

 

6. Double click RKDevTool.exe to open the upgrade window; 

 

  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 IBOX66 | User Manual               39            www.vantrontech.com 

7. Connect IBOX66 to the Windows host with the USB Type-A to Type-A cable; 

8. Press “Win + R” and input cmd in the dialog box to open the command prompt;  

9. Input adb devices in the command prompt to check if the device is connected to the 
Windows host; 

10. Once the device is identified by the Windows host, input adb reboot loader to reboot 
the device into the bootloader mode; 

11. Then the upgrade window will prompt for the existence of a Loader device, indicating 
that the upgrade process is ready. 

 

12. Click Upgrade Firmware > Firmware in the upgrade window; 

13. Open the image file update.img from the local directory (\SW\Image), and the 
firmware details will be automatically populated; 

14. Click the Upgrade button and the system will start to download the image and upgrade 
the firmware automatically; 

 

15. When the upgrade finishes, the system will reboot automatically.   
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4.6 Serial Ports 

IBOX66 offers two DB9 RS232 connectors (uart4 and uart5) and two DB9 RS232/RS485 
connectors (uart0 and uart7) for serial communication. 

To test if the serial ports function properly: 

1. Connect the device to a Linux host (Ubuntu 22.04 for instance) with the USB cable 
(Type-A to Type-A); 

2. Use a proper serial adapter to connect the target serial port to a serial device; 

Refer to 3.9 for the pinout description of the ports. 

3. Open a terminal and install a serial communication program (‘microcom’ for instance); 

$ sudo apt install microcom 

4. Input the following command line to install ADB tool; 

$ sudo apt install adb 

5. Check if the Device is connected to the Linux host via ADB; 

$ adb devices -l 

 

 

 

6. Input adb shell in the terminal to execute shell commands on the Device; 

 

 

 

 

 

 

7. Input su in the terminal to switch to the root user; 
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8. Enter cd sys/van-misc to access the directory of the serial ports as follows: 

 

 

9. Set the baud rate (9600 for instance) of the serial ports (uart4 for instance); 

# microcom -s 9600 /dev/ttyS4 

<Text the data to send to the connected device> 

10. For the RS232/RS485 ports, input the following commands to switch the serial mode of 
the port: 

# echo 1 > sys/van-misc/uart0_mode      // uart0 RS232 mode 

# echo 0 > sys/van-misc/uart0_mode      // uart0 RS485 mode 

# echo 1 > sys/van-misc/uart7_mode      // uart7 RS232 mode 

# echo 0 > sys/van-misc/uart7_mode      // uart7 RS485 mode  

 

4.7 GPIO 

IBOX66 provides 8 GPIOs, starting from GPIO0 to GPIO7. GPIO0 to GPIO7 are mapped as 
GPIO104, GPIO107, GPIO108, GPIO109, GPIO110, GPIO111, GPIO112, and GPIO113 in the 
software system, respectively. 

Please refer to 3.12 for the pinout description of the GPIOs. 

Before you start to use the GPIOs, please install the ADB tool on the Linux host, if necessary, 
as set out in step 4 in 4.6. 

1. Execute adb shell command in the terminal; 

2. Input the following commands to access the directory of the GPIOs and check the GPIO 
nodes: 

~# cd sys/class/gpio/ 

 /sys/class/gpio # ls 
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3. Set a GPIO (GPIO104 for instance) to the high level; 

# echo 1 > /sys/class/gpio/gpio104/value 

# cat /sys/class/gpio/gpio104/value 

4. Set a GPIO (GPIO104 for instance) to the low level; 

# echo 0 > /sys/class/gpio/gpio104/value 

# cat /sys/class/gpio/gpio104/value 

Follow the same way to set the levels of the remaining GPIOs. You can use a voltmeter 
to check if the settings are valid.   

 

4.8 User Indicator Control 

There is a user-defined LED indicator on the REAR enclosure of IBOX66, users can use the 
following command line to enable and disable the indicator. 

1. Install ADB tool on the Linux host, if needed, as set out in step 4 in 4.6; 

2. Execute adb shell command in the terminal; 

3. Input the following commands to enable and disable the indicator. 

# echo 1 > /sys/van-misc/user_led         [enable] 

# echo 0 > /sys/van-misc/user_led         [disable]  
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 CHAPTER 5 DEBIAN SYSTEM MANUAL 
 
 
 
 
 
 
 
 
 
  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 IBOX66 | User Manual               44            www.vantrontech.com 

This chapter briefs on the settings and common use of the Interfaces in the Debian system. 
Please connect a mouse, a keyboard and a monitor to IBOX66 for smooth operation. 

5.1 About the System 

Debian is a Linux distribution and the Device was built by Debian GNU/Linux 10 operating 
system.  

5.1.1 User and password 

The system will automatically log in without the need to input the password. However，
if you have switched the account/locked the screen/logged out, you will be prompted to 
input the password to log in the system. 

° Default user: vantron 

° Password: vantron 

5.1.2 System information 

1. Connect a mouse, a keyboard and a monitor to IBOX66; 

2. Power on the Device to login; 

3. Click the Debian icon, then click System Tools > LXTerminal in sequence to open the 
system terminal; 

4. Input cat /etc/os-release in the terminal to check the system information; 

 

5. Input sudo su to switch to the root user (no password). 
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5.2 System Settings  

By clicking on the power icon    on the bottom right corner of the screen, you can 

° Shut down/Restart/Suspend the Device 

° Lock the screen  

° Switch the user  

° Log out the current user 

 

The menu bar on the bottom of the screen: 

° Main menu: You can open accessories, applications, the console terminal, or 
customize the system settings 

° File manager: Provides access to device files, applications 

° Web browser: Provides access to webs on Internet 

° Window tool: To minimize or fold the windows 

° Desktop switch: To switch between working areas 

° CPU usage: Displays the CPU usage in real time 

° Volume menu: Adjusts the system volume 

° Virtual keyboard: To open/close the virtual keyboard, set the input method upon 
a right click of the mouse 

° Network settings: You can connect to Ethernet/Wi-Fi/VPN, or create/edit the 
connection 

° Bluetooth settings: To pair and set up the Bluetooth devices 

° System time 

° Screen lock 

° Power icon 
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5.2.1 Language setup 

Assume the system langue is Simplified Chinese. The following example demonstrates 
how to change the system langue to English (US). 

1. Right click the mouse on the desktop background; 

2. Select the desktop preference option at the bottom of the menu; 

 

3. Check the ‘show menus provided by window managers when desktop is clicked’ 
option (first line) in the advanced menu (third tab) to change the right-click menu; 

 

4. Return to the desktop background and open the terminal emulator; 

5. Input sudo su in the terminal to switch to the root mode; 

 

6. Run the following command to check the language currently used by the system; 

# env | grep LANG 
LANG= zh_CN.UTF-8            // the system language is simplified Chinese 
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7. Run the following command to call the locale configuration page (en_US.UTF-8 refers 
to the locale for the target language that you wish to switch to); 

# export LANG=en_US.UTF-8 

8. Use the following command to re-configure the locales; 

# dpkg-reconfigure locales 

9. Use the up and down arrows on the keyboard to move to the target locale 
(en_US.UTF-8); 

10. Press “Space” in front of the target locale to select the language; 

a  

11. Move down to the current locale (zh_CN.UTF-8) and press “Space” to uncheck the 
current language; 

 

12. Press “Tab” to move the cursor to the <OK> option and press “Enter” to confirm your 
choice; 
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13. In the following pop-up, use the up and down arrows to move to the target locale 
(en_US.UTF-8) in the list, then press “Tab” to move the cursor to the <OK> option and 
press “Enter” to confirm your choice; 

14. Wait a few seconds for the locale to take effect; 

 

15. Then input reboot to restart the system; 

16. Select “Update Names” after device reboot to update the files to the current 
language; 

17. Run locale -a command to check if the locale is set as the default system language. 

5.2.2 Time and date setup 

Please confirm if the system time is correct after first bootup. To change the system time: 

1. Click the Debian icon > Preference > Time and Date to open the Time and Date 
settings; 
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2. Click Unlock and enter the password (vantron) before editing; 

3. Click Time zone and select the correct one for the Device from the list; 

4. Choose to synchronize the time with the Internet server (device shall have Internet 
access) or fill in the time manually; 

5. Click Lock and close the window; 

6. Reboot the device to let the settings take effect. 

 

The real-time clock (RTC) component provides accurate time and date information for the 
system after its recovery from abrupt power failure r system fault. When necessary, follow 
the steps below to synchronize the RTC and system time. 

1. Click the Debian icon > System Tools > LXTerminal to open a terminal; 

2. Input sudo su to switch to the root user; 

3. Set the date and time for the system； 

# date -s "2023-03-24 14:38:10" 

4. Synchronize the date and time to the RTC; 

# hwclock -w 

5. Reboot the Device; 

# reboot 

6. Check the RTC information. 

# hwclock -r 
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5.2.3 Network configuration 

The Device is configured to have Internet access once it connects to a live Ethernet or joins 
to a Wi-Fi network.  

Make sure you have installed the Wi-Fi antennas before connecting to an existing wireless 
network. 

1. To join to a Wi-Fi network, click the network icon     on the menu bar and search for 
the target network in the list; 

2. Input the password of the target Wi-Fi network and wait for the connection; 

3. To check the current network connection, you can move the cursor to the network icon, 
and right click the mouse to select Connection Information: 

 

4. To edit the network configurations, you can right click the network icon and select Edit 
Connections, then select a connection and click the cog icon to edit the settings. 
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5.3 Image Flashing on a Windows Host 

Whenever a new image is available, Vantron will provide a release package consisting of 
all the tools/files necessary so that you can flash the image as needed. This section briefs 
on the image flashing on a Windows host. 

5.3.1 Prerequisites 

• IBOX66 

• A host computer running Windows 7 or later (with ADB setup finished, refer to 4.3) 

• A USB Type-A to Type-A cable 

• IBOX66 is in the device mode (OTG switch dialed up, refer to 3.4) 

5.3.2 Image flashing 

1. Unzip the software release package and open the directory of the upgrade driver 
(\DriverAssitant_vxxx) to locate the DriverInstall.exe; 

 

2. Right click the mouse and run the program as administrator; 

3. Click Uninstall Driver first to remove the previously installed driver, if any, then click 
Install Driver and wait; 
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4. A pop-up will appear in a second suggesting the driver is installed; 

 

5. Return to the release package and open the directory of the upgrade tool (path: 
\RKDevTool_Release\ RKDevTool.exe); 
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6. Double click RKDevTool.exe to open the upgrade window; 

 

7. Connect the USB OTG port (refer to 3.4) of IBOX66 to the Windows host with the USB 
Type-A to Type-A cable; 

8. Press “Win + R” and input cmd in the dialog box to open the command prompt;  

9. Input adb devices in the command prompt to check if the Device is connected to the 
Windows host; 

10. Once the device is identified by the Windows host, input adb reboot loader to reboot 
the device into the bootloader mode; 

11. Then the upgrade window will prompt for the existence of a Loader device, indicating 
that the upgrade process is ready. 
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12. Click Upgrade Firmware > Firmware in the upgrade window; 

13. Open the image file update.img from the local directory (\rockdev), and the firmware 
details will be automatically populated; 

14. Click the Upgrade button, and the system will start to download the image and 
upgrade the firmware automatically; 

 

15. When the upgrade finishes, the system will reboot automatically.  

  

http://www.vantrontech.com/


Vantron| Embedded in your success, Embedded in your better life 
World-leading provider of embedded/IoT products and solutions 

 

 IBOX66 | User Manual               55            www.vantrontech.com 

5.4 Serial Ports 

IBOX66 offers two DB9 RS232 connectors (UART4 and UART5) and two DB9 RS232/RS485 
connectors (UART0 and UART7) for serial communication. The ports are mapped as 
/dev/ttyS0, /dev/ttyS4, /dev/ttyS5, and /dev/ttyS7 respectively in the system. Please refer 
to 3.9 for the details of the serial ports. 

To switch the serial modes of UART0 and use it for serial communication: 

# echo 20 > /sys/class/gpio/export              // To export the pin 

# echo out > /sys/class/gpio/gpio20/direction    // To configure the pin as an output 

# echo 0 > /sys/class/gpio/gpio20/value   // To enable the RS485 mode 

# echo 1 > /sys/class/gpio/gpio20/value     // To enable the RS232 mode 

# busybox microcom -t 5000 -s 4800 /dev/ttyS0   // To use the ‘microcom’ utility to set 
a timeout of 5s for data transmission and set the baud rate to 4800  

 

To switch the serial modes of UART7 and use it for serial communication: 

# echo 5 > /sys/class/gpio/export              // To export the pin 

# echo out > /sys/class/gpio/gpio5/direction    // To configure the pin as an output 

# echo 0 > /sys/class/gpio/gpio5/value   // To enable the RS485 mode 

# echo 1 > /sys/class/gpio/gpio5/value     // To enable the RS232 mode 

# busybox microcom -t 5000 -s 4800 /dev/ttyS7   // To use the ‘microcom’ utility to set 
a timeout of 5s for data transmission and set the baud rate to 4800  

 

To set UART4 and use it for serial communication: 

stty -F /dev/ttyS4 speed 115200 // To use the ‘stty’ utility to set the baud rate to 115200 

echo abcd  > /dev/ttyS4    // To send ‘abcd’ to UART4 

cat /dev/ttyS4           // To read the data sent to UART4 and output to the terminal 

 

To set UART5 and use it for serial communication: 

# stty -F /dev/ttyS4 speed 115200 // To use the ‘stty’ utility to set the baud rate to 115200 

# echo abcd > /dev/ttyS5    // To send ‘abcd’ to UART5 

# cat /dev/ttyS5          // To read the data sent to UART5 and output to the terminal
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5.5 Use of Debug UART 

In the event that you would like to debug the device via the debug UART, please unscrew 
the upper cover of IBOX66 first. 

1. Use a Philips screwdriver to remove the screws from the upper cover and open IBOX66; 

 

 

 

 

 

2. The debug UART is labeled as J18, and the pinout description is shown below; 

 

 

 

 

 

 

 

3. Insert the male ends of three male-to-female DuPont wires into the pinholes of J18 
connector, and the other ends into the serial headers of a serial-to-USB adapter (TXD-
RXD, RXD-TXD, GND-GND); 

 

 

 

 

 

 

 

  

J18 

J18 Pinout 

Black, red, brown: GND, RXD, TXD 

Black, red, brown: GND, TXD, RXD 
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4. Plug the USB end of the serial-to-USB adapter into the host computer; 

5. Power on IBOX66 with a 12V DC adapter; 

6. Launch a terminal emulator on a host computer (in the following description, a 
terminal in ubuntu system is used for illustration) 

7. Identify the device name of the serial-to-USB adapter mapped in the software system; 

$ ls /dev/ttyUSB* 

8. Use a serial communication program (e.g., minicom) to set the parameters of the 
debug UART; 

$ sudo apt-get install minicom    //install minicom 

9. Open the debug UART; 

$ sudo minicom -D /dev/ttyUSB0 -b 115200 

10. Press Ctrl + A and release, then press O to open the port configurations;  

11. Use the keyboard to navigate to the Serial port setup option;  

12. Set the baud rate, data bit, parity, and stop bit (8N1) without hardware or software 
flow control; 

 

13. Press Enter to save the settings and return to the configuration window; 

14. Navigate to Save setup as dfl and press Enter to save the changes to default settings; 

15. Exit the settings and you can now proceed with debugging the device. 
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5.6 4G module 

IBOX66 integrates an automatic dial-up script. The dial-up fails when there is no SIM card 
in the slot, yet the normal operation of the Device will not be impacted. 

Before using the cellular communication, please remember to insert the activated SIM 
card into the SIM slot and install the 4G antennas before power up. 

1. The dial-up script runs automatically upon power up; 

2. Use the ifconfig command to check the information of the network card (PPP0 in this 
case) after successful dial-up; 

 

3. Add a default route; 

# route add default gw 10.58.143.126     // use the IP address obtained by ppp0 

4. Test the network connection using the ping command. 
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5.7 Ethernet 

IBOX66 is configured to connect to Internet once it connects to a live Ethernet. 

1. Connect the RJ45 Ethernet jack of the Device to network; 

2. Use the ifconfig command to check the information of the network card (eth0 in this 
case); 

 

3. Test the network connection using the ping command. 

 

5.8 Wi-Fi 

1. Check the Wi-Fi status of the Device; 

# nmcli radio wifi 

2. Make sure the Wi-Fi feature is enabled. If not, use the following command; 

# nmcli radio wifi on 

3. Check available Wi-Fi access points; 

# nmcli dev wifi list 

4. Connect the Device to a Wi-Fi access point using nmcli.   

# sudo nmcli dev wifi connect [network ssid] password [network password]  
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5.9 USB 

When any of the USB interfaces connects to a storage device, input the following 
commands to check/configure the USB interface. 

1. Display the details of the partitions on the USB device: 

$ fdisk -l 

2. Mount the USB device to a specified directory (e.g., /mnt): 

$ mount /dev/xxx /mnt 

3. Check the mounted content in /mnt: 

$ ls /mnt 

4. Unmount the USB device from /mnt: 

$ umount /dev/mnt 

5.10 RTC 

RTC module provides accurate time and date information to the system. Follow the steps 
below to change the RTC time. 

1. Access the time zone settings; 

# Tzselect           // You can then follow the prompts to change the time zone 

2. Copy the time zone information (Shanghai, China for instance) to the local file; 

# sudo cp /usr/share/zoneinfo/Asia/Shanghai /etc/localtime 

3. Set the system date & time;  

# date -s "2023-03-24 14:38:10" 

4. Synchronize the RTC time with the system time; 

# hwclock -w 

5. Reboot the Board; 

# reboot 

6. Check the RTC time information. 

# hwclock -r 
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6.1 Disposal 

When the device comes to end of life, you are suggested to properly dispose of the device 
for the sake of the environment and safety. 

Before you dispose of the device, please back up your data and erase it from the device. 

It is recommended that the device is disassembled prior to disposal in conformity with 
local regulations. Please ensure that the abandoned batteries are disposed of according 
to local regulations on waste disposal. Do not throw batteries into fire or put in common 
waste canister as they are explosive. Products or product packages labeled with the sign 
of “explosive” should not be disposed of like household waste but delivered to specialized 
electrical & electronic waste recycling/disposal center.  

Proper disposal of this sort of waste helps avoid harm and adverse effect upon 
surroundings and people’s health. Please contact local organizations or recycling/disposal 
center for more recycling/disposal methods of related products. 
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6.2 Warranty  

Product warranty 

VANTRON warrants to its CUSTOMER that the Product manufactured by VANTRON, or its 
subcontractors will conform strictly to the mutually agreed specifications and be free from 
defects in workmanship and materials (except that which is furnished by the CUSTOMER) 
upon shipment from VANTRON. VANTRON’s obligation under this warranty is limited to 
replacing or repairing at its option of the Product which shall, within 24 months after 
shipment, effective from invoice date, be returned to VANTRON’s factory with 
transportation fee paid by the CUSTOMER and which shall, after examination, be 
disclosed to VANTRON’s reasonable satisfaction to be thus defective. VANTRON shall bear 
the transportation fee for the shipment of the Product to the CUSTOMER. 

Out-of-Warranty Repair 

VANTRON will furnish the repair services for the Product which are out-of-warranty at 
VANTRON’s then-prevailing rates for such services. At customer’s request, VANTRON will 
provide components to the CUSTOMER for non-warranty repair. VANTRON will provide 
this service as long as the components are available in the market; and the CUSTOMER is 
requested to place a purchase order up front. Parts repaired will have an extended 
warranty of 3 months. 

Returned Products 

Any Product found to be defective and covered under warranty pursuant to Clause above, 
shall be returned to VANTRON only upon the CUSTOMER’s receipt of and with reference 
to a VANTRON supplied Returned Materials Authorization (RMA) number. VANTRON shall 
supply a RMA, when required within three (3) working days of request by the CUSTOMER. 
VANTRON shall submit a new invoice to the CUSTOMER upon shipping of the returned 
products to the CUSTOMER. Prior to the return of any products by the CUSTOMER due to 
rejection or warranty defect, the CUSTOMER shall afford VANTRON the opportunity to 
inspect such products at the CUSTOMER’s location and no Product so inspected shall be 
returned to VANTRON unless the cause for the rejection or defect is determined to be the 
responsibility of VANTRON. VANTRON shall in turn provide the CUSTOMER turnaround 
shipment on defective Product within fourteen (14) working days upon its receipt at 
VANTRON. If such turnaround cannot be provided by VANTRON due to causes beyond the 
control of VANTRON, VANTRON shall document such instances and notify the CUSTOMER 
immediately. 
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Appendix Regulatory Compliance Statement 

FCC Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

This device complies with Part 15 of FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) This device must 
accept any interference received, including interference that may cause undesired operation. 

Note: The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the user’s 
authority to operate this equipment. 
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